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Project Title 
Training faculty and students to use the BOSS LS-2440 

 

Step 1: Identify Instructional Goal(s)  
Problem and Opportunity 
The University of Redlands art department purchased a BOSS LS-2440 laser cutter to replace the 
old Epilog Legend laser cutter. Currently, I and two other faculty know how to create vector and 
raster images for the laser cutter, import them successfully into the software used to run the laser 
cutter (Lightburn), and operate the laser cutter. 

I will design and implement a course to train faculty and students in the art department to create 
vector and raster images for the laser cutter, import them successfully into the software used to 
run the laser cutter (Lightburn), and operate the laser cutter.   

Instructional Goal  
The student will be able to use the BOSS LS-2440 to cut and etch various materials. 

●​  

General Overview of the Learners, Contexts, and Tools  
The learners are faculty and students in the art department at the University of Redlands. There is 
a mix of graduate and undergraduate education. They should all be motivated to learn this new 
production technique, have college-level reading and comprehension skills, and possess a basic 
understanding of using computers including opening files and using removable storage media. 
Perhaps I can make ART159 a prerequisite or include this eLearning in ART159. 

The learners will apply their new skills in Ann Peppers Hall room 222 where the laser cutter is 
installed. 

The learners will need sheet material that is appropriate for the laser cutter, vector files for 
cutting the material, and raster files for etching the material. Learners will also need removable 
storage media formatted to FAT 32. 

Step 2: Conduct Instructional Analysis 
Major Steps 
This instructional goal falls under the Psychomotor Domain as the students will be learning to 
operate machinery, follow steps, and integrate skills. Some of the sub skills also fall under the 
Cognitive Domain as the students will need to understand vector art, raster art, resolution, 
imperial-metric conversion. 
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Subordinate and Entry Skills 
I’ve selected “Import vector files (SVG, AI, DXF) and raster images (JPG, PNG)” to break down 
into its constituent sub skills and have denoted entry behaviors with a dashed line: 
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Step 3: Analyze Learners and Contexts 
Target Population and Performance Setting 
The learners are faculty and students in the art department at the University of Redlands. There is 
a mix of graduate and undergraduate education. They should all be motivated to learn this new 
production technique, have college-level reading and comprehension skills, and possess a basic 
understanding of using computers including opening files and using removable storage media.  

All of the technology needed to achieve the Terminal Objective is provided by the university. 
The laser cutter itself is in a second-floor classroom with just enough space for a few people, so 
somebody with mobility issues might find it uncomfortable. There is elevator accessibility to the 
second floor.  

The learners will apply their new skills in Ann Peppers Hall room 222 where the laser cutter is 
installed. 

The learners will interact with this course through the University’s LMS, Canvas. 

 

🔹 Stop here for your Analysis Report 

 

Step 4: Write Performance Objectives 
Terminal Objective and Subordinate Objectives 
Using the BOSS LS-2440, the student will demonstrate proper startup procedures, explain 
relevant safety precautions, utilize LightBurn software in order to etch and cut appropriate 
materials, and demonstrate proper shutdown and cleanup procedures. 

Subordinate Objectives 
●​ Accurately identify the main components of the laser cutter when presented with the machine 

in an operational state, without missing any parts. 

●​ Correctly identify the safety features of the laser cutter when given a functional machine and a 

safety checklist, without missing any required features. 

●​ Distinguish between examples of cutting and etching when shown physical or digital samples, 

with 100% accuracy. 

●​ Explain how laser power and speed affect material processing when given different material 

samples and machine settings, demonstrating an understanding of depth, burn marks, and 

efficiency. 

●​ Perform proper startup and shutdown procedures for the BOSS LS-2440 following the guidelines, 

without skipping any steps. 

●​ Calibrate the laser focus to ensure precise cutting and engraving, achieving sharp and accurate 

results on test materials. 
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●​ Position materials properly on the workbed using hold-down methods to prevent movement 

during operation, ensuring proper alignment and cutting accuracy. 

●​ Open and set up a new project in LightBurn when provided with the software and a design file, 

ensuring all settings are correctly configured. 

●​ Assign different layers for cutting, scoring, and engraving in the same job using LightBurn 

software, with correct layer settings and differentiation. 

●​ Optimize the cutting order in LightBurn to reduce heat buildup and prevent warping, ensuring 

material integrity and reducing cycle time. 

●​ Configure multi-pass operations for thicker materials or deeper engravings using LightBurn 

settings, achieving the desired depth without excessive burning. 

●​ Import vector files (SVG, AI, DXF) and raster images (JPG, PNG) into LightBurn, ensuring correct 

scaling and positioning. 

●​ Select and apply appropriate layer settings (power, speed, passes) based on material type, 

achieving clean and efficient cuts or engravings. 

●​ Differentiate between cutting, engraving, and marking operations when given sample materials 

and LightBurn settings, explaining the effects of each process. 

●​ Optimize laser parameters for wood, acrylic, leather, metal, and other materials based on a 

provided materials reference chart, achieving precise and clean results. 

●​ Use the Frame tool in LightBurn before running a job to check material alignment, ensuring the 

design fits within the intended work area. 

●​ Adjust power and speed settings based on test results, achieving the desired cut depth or 

engraving clarity without excessive charring. 

●​ Convert grayscale images for high-quality dithering and engraving using LightBurn’s image 

processing tools, ensuring clarity and contrast in the final output. 

●​ Properly remove cut and etched materials without damaging the final product, ensuring a clean 

and professional finish. 

●​ Inspect and clean the work area after using the laser cutter, removing all debris and flammable 

residues to maintain safety. 

●​ Store leftover materials and tools in designated storage areas, keeping the workspace organized 

and preventing material damage. 

●​ Evaluate the final product for quality against a provided checklist, making necessary adjustments 

for improvement. 

●​ Follow machine shutdown and maintenance procedures as outlined in the manufacturer’s 

manual, ensuring the laser cutter remains in optimal working condition. 

Step 5: Develop Assessment 
Instruments 
Assessment Instruments  
Hint: Create assessments that align with your performance objectives. Ensure test items match 
the behaviors described in each objective. Create rubrics to guide learners’. 
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Multiple Choice Entry Skills Test 

Instructions: Select the best answer for each question. 

 

1. Which of the following file types is considered vector art? 

A.​ JPEG 
B.​ PNG 
C.​ SVG (correct answer) 
D.​ GIF 

 

2. What keyboard shortcut commonly allows you to "undo" your last action on a 
computer? 

A.​ Ctrl + C 
B.​ Ctrl + Z (correct answer) 
C.​ Ctrl + Alt + Delete 
D.​ Ctrl + P 

 

3. What is the proper procedure for removing a thumb drive? 

A.​ Pull it out of the computer 
B.​ Select “Eject” from the File Explorer then remove the drive (correct answer) 
C.​ Push the eject button on the keyboard 
D.​ Use the cloud 

 

4. What best describes raster art? 

A.​ Scalable without quality loss 
B.​ Composed of pixels (correct answer) 
C.​ Primarily mathematical paths and shapes 
D.​ Always small file size 
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5. Which action is used to import a file into most software programs? 

A.​ File > Export 
B.​ File > Save 
C.​ File > Import (correct answer) 
D.​ Edit > Paste 

 

5. If you have an imperial measurement of 12 inches, what is the equivalent length in 
centimeters (cm)? 

A.​ 12 cm 
B.​ 24 cm 
C.​ 30.48 cm (correct answer) 
D.​ 48 cm 

 

6. Vector art is primarily composed of: 

A.​ Pixels 
B.​ Paths and nodes (correct answer) 
C.​ Shaded pixels 
D.​ Photos and scanned images 

 

6. Which of the following file formats would most likely lose quality when scaled up 
significantly? 

A.​ DXF 
B.​ SVG 
C.​ AI 
D.​ JPG (correct answer) 

 

7. What shortcut is typically used to copy text or objects on most computer systems? 

A.​ Ctrl + C (correct answer) 
B.​ Ctrl + V 
C.​ Ctrl + Z 
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D.​ Ctrl + S 

 

7. How many millimeters (mm) are in one inch? 

A.​ 10 mm 
B.​ 25.4 mm (correct answer) 
C.​ 30 mm 
D.​ 2.54 mm 

 

8. Vector images primarily consist of: 

A.​ Pixels 
B.​ Color gradients 
C.​ Mathematical paths (correct answer) 
D.​ Raster grids 

 

Answer Key: 1-C, 2-C, 3-B, 4-D, 5-C, 6-D, 7-B 

Pretest: General Laser Cutting Knowledge 

Instructions: Select the best answer for each question. 

 

1. What is the primary function of a laser cutter? 

A.​ Melting metal for welding 
B.​ Cutting and engraving materials using a focused laser beam (correct answer) 
C.​ Printing designs onto paper 
D.​ Mixing chemical solutions 

 

2. Which of the following materials is unsafe to cut with a laser cutter due to toxic fumes? 

A.​ Acrylic 
B.​ Plywood 
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C.​ PVC (correct answer) 
D.​ Cardboard 

 

3. What safety precaution should always be taken before starting a laser cutting job? 

A.​ Ensuring the ventilation system is on (correct answer) 
B.​ Leaving the machine unattended to work faster 
C.​ Using higher power settings for efficiency 
D.​ Holding the material by hand during the cut 

 

4. What happens if the laser focus is not properly calibrated? 

A.​ The laser cutter will shut down automatically 
B.​ The cutting and engraving results may be blurry or incomplete (correct answer) 
C.​ The material will always burn completely through 
D.​ The laser will become stronger 

 

5. What is the emergency stop button used for? 

A.​ Increasing laser power 
B.​ Resetting the machine after a job 
C.​ Immediately stopping all machine functions for safety (correct answer) 
D.​ Pausing the job for adjustments 

 

6. Why should you avoid stacking multiple layers of material when cutting? 

A.​ The laser will cut through all layers cleanly 
B.​ It may cause inconsistent cuts and fire hazards (correct answer) 
C.​ It helps speed up the cutting process 
D.​ It ensures higher precision in engraving 

 

7. What type of file is best for vector cutting in LightBurn? 
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A.​ JPEG 
B.​ PNG 
C.​ SVG (correct answer) 
D.​ BMP 

 

8. What should you do if a fire starts inside the laser cutter? 

A.​ Open the lid to blow it out 
B.​ Turn off the machine and use a fire extinguisher if needed (correct answer) 
C.​ Increase the air assist to put it out 
D.​ Continue the job and hope it burns out 

 

9. Why is it important to remove leftover debris after cutting? 

A.​ It improves ventilation efficiency 
B.​ Debris can catch fire if left in the machine (correct answer) 
C.​ It helps future jobs run faster 
D.​ It makes the machine look clean for the next user 

 

10. What is the purpose of air assist in a laser cutter? 

A.​ To cool down the laser tube 
B.​ To blow debris away and prevent flare-ups (correct answer) 
C.​ To increase laser power 
D.​ To enhance engraving detail 

 

Answer Key: 1-B, 2-C, 3-A, 4-B, 5-C, 6-B, 7-C, 8-B, 9-B, 10-B 

Module 3 Test: File Types and LightBurn Settings 

Instructions: Select the best answer for each question. 

 

1. Which file type is NOT commonly used for laser cutting? 
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A.​ SVG 
B.​ AI 
C.​ BMP (correct answer) 
D.​ DXF 

 

2. What is the difference between vector and raster graphics? 

A.​ Vector graphics use pixels, raster graphics use paths 
B.​ Raster graphics use pixels, vector graphics use paths (correct answer) 
C.​ Both are the same and can be used interchangeably 
D.​ Vector graphics are only for photographs 

 

3. Which of the following is a correct power and speed setting guideline? 

A.​ Higher power and slower speed for deep cuts (correct answer) 
B.​ Higher power and higher speed for deep cuts 
C.​ Lower power and lower speed for deep cuts 
D.​ Speed and power settings don’t affect depth 

 

4. What is the purpose of layer colors in LightBurn? 

A.​ To visually separate designs 
B.​ To assign different cutting and engraving operations (correct answer) 
C.​ To make the design more colorful 
D.​ They have no function in laser cutting 

 

5. Which LightBurn tool helps ensure the design fits within the work area? 

A.​ Arrange Tool 
B.​ Framing Tool (correct answer) 
C.​ Fill Tool 
D.​ Align Tool 
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6. What does increasing the number of passes in LightBurn do? 

A.​ Reduces laser power 
B.​ Increases cutting depth (correct answer) 
C.​ Makes engraving less visible 
D.​ Decreases speed 

 

7. What is the best way to avoid overheating and warping when laser cutting? 

A.​ Cut the job in one single pass with high power 
B.​ Use multiple light passes with moderate power (correct answer) 
C.​ Cut as fast as possible 
D.​ Reduce air assist completely 

 

8. What is a common issue when using JPEG images in LightBurn? 

A.​ They are not scalable without losing quality (correct answer) 
B.​ They always engrave with high detail 
C.​ They work the same as vector images 
D.​ They are preferred for cutting operations 

 

9. How does the “Fill” mode in LightBurn affect engraving? 

A.​ It creates vector outlines 
B.​ It fills engraved areas with a pattern (correct answer) 
C.​ It increases cutting speed 
D.​ It prevents engraving altogether 

 

10. When importing a DXF file into LightBurn, what is a common issue that may need 
correction? 

A.​ File size reduction 
B.​ Missing text layers 
C.​ Double overlapping lines (correct answer) 
D.​ Converting it to raster 
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Answer Key: 1-C, 2-B, 3-A, 4-B, 5-B, 6-B, 7-B, 8-A, 9-B, 10-C 

Grading Criteria for the final project: 

●​ Correct file preparation and setup. 
●​ Successful execution of cutting/engraving. 
●​ Adherence to safety and cleanup procedures. 
●​ Quality of the final product. 

 

Step 6: Develop Instructional Strategy 
Learning Components 
Hint: Use information from Steps 1-3 to define an effective instructional strategy.  

What you will include here: 

●​ Descriptions of preinstructional activities 
●​ Descriptions of presentation of information 
●​ Descriptions of learner participation 
●​ Descriptions of assessment 
●​ Descriptions of follow-through activities. 

📌 Use tables to organize your instructional strategy. Tables 8.9 to 8.12 in chapter 8 provide 
excellent examples. 

Learning Components Considerations for Each 
Component 

Instructional Strategy  

Preinstructional Activities   

Presentation Activities    

Learner Participation   

Assessment   

Follow-Through   
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Step 7: Develop & Select Instructional 
Materials 
Instructional Materials  
Hint: Develop materials based on your instructional strategy. Refer to Chapter 10 for guidance. 

The types of materials I plan to create are a canvas shell, 6 modules, video walk throughs, 
illustrations, and a wiki to allow the users to build a knowledge base. The types of materials I 
create are aligned with the instructional goal and will represent the information in multiple 
formats for accessibility. 
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Storyboard 

🔹Stop here for your Design and Storyboard 

​ ​ 15 

 



 

 

 

Step 8: Formative Evaluation and 

Revision 
Implement and evaluate materials 
Hint: Follow formative evaluation phases: 

1.​ One-to-one evaluation – Test with individuals from the target group. 
2.​ Small-group evaluation – Conduct a trial with a small group from the target population. 
3.​ Field trial – Test on the intended learning environment. 
4.​ Summarize and analyze data from one-to-one trials, small-group trials, and field trials. 
5.​ Revise instructional materials and procedures using learner-based data tables that 

indicate areas of strength and problems in the materials or procedures. 

Evaluation Methods & Materials 
I conducted the one-on-one evaluation with my wife and she provided some very prescient 
feedback on the format of my current design.   

Small-group and field-trial will be conducted by email using the pre-test and post-test. 

Data Collected 
The first comment was to make the formatting of each module consistent. The use of emojis on many of 

the head levels was distracting and looked messy. It was suggested that I create module overview pages 

and link the landing page to those instead of the modules—if the learner wants to view the modules, 

they can use the Module navigation provided by Canvas. 

Revisions 
I deleted most of the emojis from the Heads, but I left a few in as visual cues for important warnings. I 

created module overview pages and restated the module objectives from the landing page for each 

module. 

🔹Stop here for your Formative Evaluation & Revision 

 

Step 9: Summative Evaluation  
Expert Judgment Phase Only 
Summative evaluation has two stages: expert judgment and impact analysis. Hint: Complete the 
expert judgment phase, rather than the impact phase. 
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https://forms.office.com/r/jauYNsFjE7


 

The main purpose of a summative evaluation is to figure out whether the instruction actually 
worked—did it do what it was supposed to do, and was it worth the time and resources? It’s not 
about tweaking things mid-course (that’s formative); it’s about stepping back at the end and 
asking big-picture questions: Did learners meet the goals? Did the instruction have a measurable 
impact? Would we recommend it—or change it—based on real evidence? Summative evaluation 
helps justify decisions (keep, revise, toss) and gives stakeholders the kind of results they actually 
care about—especially when there’s budget, scale, or policy on the line. 

I’m still waiting to get results from my Expert Judgment evaluation, but I created a fairly simple 
instrument to ask the main questions of my evaluator. They were all-open ended questions: 

1.​ Please provide feedback on your experience with the course. 
2.​ Was there anything you found confusing or difficult to follow? 
3.​ Do you feel the information was sufficiently presented in  different formats for the 

learners? 
4.​ Did you catch any mistakes? Please enumerate them here. 
5.​ Any suggestions for improving this training module? 

There are some recommendations that I came up with to improve the course: I need more video 
walkthroughs for sub-processes. I created one for focusing the laser and for the startup 
procedure, but the final module needs more video walkthroughs—positioning the material and 
running the whole job. I can get around to that during the summer. 

🔹Stop here for your Summative Evaluation 

 

 

Final Project  
Final Reflection & Project URL 
Hint: Reflect on your experience following the Dick and Carey Model throughout your 
instructional design project. 

Designing this Canvas course using the Dick and Carey model gave me structure—but also 
exposed how messy real-life instructional design can be. Breaking everything down into discrete 
steps made the whole process feel less overwhelming; I always had a clear “next move.” That 
said, translating a studio-based, hands-on subject into clean modules with measurable objectives 
wasn’t easy. One challenge I ran into early was making sure my performance objectives actually 
aligned with what learners would do—not just what they’d vaguely “understand.” I kept catching 
myself writing outcomes that were too soft or too broad. 

To fix that, I leaned back into the model—especially the steps on instructional analysis and 
performance objectives—and forced myself to articulate the exact observable skills each module 
needed to deliver. Another challenge: the evaluation piece. It's tempting to skip ahead and just 
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build the course, but forcing myself to draft pretests and formative checks made the content 
stronger. It revealed gaps I hadn’t noticed. 

I really like the explicit nature of the Dick and Carey model—while I can map the steps from 
ADDIE to the steps from Dick and Carey, having the explicit instructions laid out in the steps 
themselves is quite helpful. I think I was able to remember the Dick and Carey steps more clearly 
than the ADDIE steps even without the helpful mnemonic. (Sometimes I find myself thinking 
through the ADDIE mnemonic in order to describe Dick and Carey.) 

Honestly, the biggest shift was letting go of perfection early on—using the model iteratively, 
revising as I went, and trusting that the structure would hold. 

I still have some summative evaluation to finish this summer as I’ve already imported this course 
into the University’s  Canvas system and am presenting it to the ID team there to get feedback 
for more revisions. Because I’ve been a graphic designer for my entire adult life, the concept of 
“never being done” is not new to me. I’ll continue to refine this job aid as new technology 
emerges and as feedback is received. 

The link to my final project is a Canvas course that you must sign up for. You can visit an HTML 
facsimile of the course as well. 
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